Chapter 11 Email

Shambhavi Roy

Clinton Daniel
University of South Florida, cedanie2@usf.edu

Manish Agrawal
University of South Florida, magrawal@usf.edu

Follow this and additional works at: https://digitalcommons.usf.edu/dit_tb_eng

Scholar Commons Citation
Roy, Shambhavi; Daniel, Clinton; and Agrawal, Manish, "Chapter 11 Email" (2023). FUNDAMENTALS OF INFORMATION TECHNOLOGY: Textbook – English. 11.
https://digitalcommons.usf.edu/dit_tb_eng/11

This Book Chapter is brought to you for free and open access by the The Modernization of Digital Information Technology at Digital Commons @ University of South Florida. It has been accepted for inclusion in FUNDAMENTALS OF INFORMATION TECHNOLOGY: Textbook – English by an authorized administrator of Digital Commons @ University of South Florida. For more information, please contact digitalcommons@usf.edu.
<table>
<thead>
<tr>
<th>CHAPTER CONTENTS</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>216</td>
</tr>
<tr>
<td>Email Origins</td>
<td>216</td>
</tr>
<tr>
<td>Email Impacts</td>
<td>217</td>
</tr>
<tr>
<td>Email Technologies</td>
<td>217</td>
</tr>
<tr>
<td>Mail Clients</td>
<td>218</td>
</tr>
<tr>
<td>Desktop Mail Clients</td>
<td>219</td>
</tr>
<tr>
<td>Mobile Mail Clients</td>
<td>219</td>
</tr>
<tr>
<td>Receiving, Creating, and Forwarding Mails</td>
<td>220</td>
</tr>
<tr>
<td>Organizing Email into Folders</td>
<td>225</td>
</tr>
<tr>
<td>Mail Labels</td>
<td>225</td>
</tr>
<tr>
<td>Mailing Lists</td>
<td>226</td>
</tr>
<tr>
<td>Mail Filters and Rules</td>
<td>226</td>
</tr>
<tr>
<td>Managing Signatures</td>
<td>228</td>
</tr>
<tr>
<td>Email Sensitivity, Security, and Delivery Options</td>
<td>230</td>
</tr>
<tr>
<td>Email Contacts</td>
<td>232</td>
</tr>
<tr>
<td>Automated Messages</td>
<td>232</td>
</tr>
<tr>
<td>Using Calendars to Schedule Meetings and Tasks</td>
<td>234</td>
</tr>
<tr>
<td>Email Security</td>
<td>238</td>
</tr>
<tr>
<td>Phishing Attacks</td>
<td>239</td>
</tr>
<tr>
<td>Spear Phishing</td>
<td>239</td>
</tr>
<tr>
<td>Emails Don’t Go Away</td>
<td>240</td>
</tr>
<tr>
<td>Chapter Terms and Definitions</td>
<td>241</td>
</tr>
<tr>
<td>Chapter Case: I’m Admitted to USF!</td>
<td>2431</td>
</tr>
</tbody>
</table>
To not have an email address is the digital equivalent of being homeless. Without it you can’t shop online, bank online or engage with social media.

—Dela Quist, email marketing leader and founder of Alchemy Worx

Overview

Email is the method of sending, receiving, and organizing messages using a computer. Barely a few decades ago, the only way to send messages and documents was to mail them physically at the post office (or use courier services like FedEx and UPS). Email transformed the way we communicate. It allows us to send and receive messages and documents instantaneously, regardless of the physical location of the sender or the receiver. Along with services like instant messaging and video calling, email spurred global e-commerce by breaking geographical barriers and allowing friends and family to stay in touch on a day-to-day basis for little to no cost. To mail a letter through the postal service, you needed to write the letter or take a printout of the letter, put it in an envelope, attach stamps, and write the mailing address on the envelope. If you have access to a smart phone or computer, email is much easier. You only need to know the email address of the person you want to email, then type the message, and include any documents you want to attach to the message. Clicking the “Send” button will instantly transfer the email from your inbox to the receiver's inbox, while you continue to work on your computer.

Email is critical for students and adults in the modern world. As a high schooler, you probably receive important notifications from your school and are required to submit assignments through email. These days, most job applications are sent and received through email because email not only helps deliver information and documents but also serves as a permanent record of your interactions. When you shop online for clothes or use food delivery services, you may get an email or a text message that you can refer to for details or in case of a disagreement with the other party. A critical feature of email compared to instant messaging is that emails are stored in virtual mailboxes, and have the advantage of never getting lost, unless deleted deliberately. In most cases, depending on your email provider, you will be able to restore even deleted messages from the Trash folder for a period of time.

Email Origins

Message passing was one of the first uses of computers. The earliest electronic communication systems were like leaving a note on a user’s desk. Users could leave a message in a specific folder on another user’s computer, who could then open the message at their convenience. When the Internet became available, users wanted to send messages to anyone connected to a computer. This introduced the need for consistent ways of doing several things such as identifying computers, identifying users on computers, and packaging messages. In 1972, Ray Tomlinson used the “@” symbol already available on computer keyboards to create the simple “user@computer” convention for identifying users and

---

139 Even after you delete email, service providers go through a detailed process to ensure the email is deleted from all their servers. Google’s policies are described at, “How Google Retains Data We Collect,” https://policies.google.com/technologies/retention (accessed June 2023).

computers, a convention that lives on to this day. In 1973, Tomlinson co-authored RFC 561, a simple three-page document that standardized the email fields we still use today, such as “FROM,” “SUBJECT.” In 2011, on the occasion of MIT’s 150th anniversary, The Boston Globe rated Tomlinson the fourth most significant inventor from MIT.

As email gained popularity, accounting for as much as 75% of all Internet traffic in the early days, protocols and applications emerged to make it easier for users to send and receive email. This chapter describes these applications in detail.

**Email Impacts**

The popularity of email is based on its unique ability to meet the human need to communicate. Email has even had significant impact on the business world. The dot-com boom of 2000, one of the greatest financial manias of all time, can be associated with email. In one of the best-known books on market manias, author Charles Kindleberger has attributed the dot-com bubble to email and related technologies. The book states that “events that lead to a [financial] crisis start with a ‘displacement,’ some exogenous, outside shock to the macroeconomic system.” In other words, a financial mania begins with some unanticipated event that has great economic impact. Further, to describe the dot-com mania, the book states that “the shock in the United States in the 1990’s was the revolution in information technology and new and lower-cost forms of communication and control that involved the computer, wireless communication and email.” The popular adoption of email led to an entire financial bubble!

**Email Technologies**

Email uses a combination of technologies to work. End users use software called mail clients to read and write email and manage their mailboxes. Service providers use software called mail servers to store and deliver emails on behalf of end users. We discuss email clients and their use in this chapter.

---

141 Google paid homage to this creative use of the “@” symbol on Oct 29, 2021 in “As Email Turns 50, the @ Symbol Continues to Fuel Collaboration,” [https://workspace.google.com/blog/productivity-collaboration/celebrating-50-years-of-email](https://workspace.google.com/blog/productivity-collaboration/celebrating-50-years-of-email) (accessed June 2023).

142 Internet Hall of Fame on Ray Tomlinson, [https://www.internethalloffame.org/inductee/raymond-tomlinson/](https://www.internethalloffame.org/inductee/raymond-tomlinson/) The four-minute video on the page is worth watching, [https://youtu.be/kJp0NHkBIAY](https://youtu.be/kJp0NHkBIAY) (both accessed June 2023).


145 As an example, most of the gadgets shown in Star Trek focused on communication, Sarah Kessler, “8 Star Trek Gadgets That Are No Longer Fiction,” [https://mashable.com/archive/star-trek-gadgets](https://mashable.com/archive/star-trek-gadgets) (accessed June 2023).

Mail Clients

A mail client is a software program that allows you to send, receive, and manage electronic messages (emails). Mail clients get messages from a mail server and display them to the user, allowing users to read, compose, and send emails as well as move emails between folders on their mail server. All operating systems now include an email client and help new users set up their email account during initial setup.

Most modern mail clients are integrated with personal productivity applications including tools for calendaring, contact management, and task management. For example, when you use Outlook (a desktop mail client), it will have a tab for managing mails, another for managing calendar events, and another for managing contacts (Figure 168). Similarly, if you use Gmail (Google’s browser-based mail client), you will also have access to Google Calendar and Google Contacts.

The mail client typically communicates with the mail server using a protocol called Internet Message Access Protocol (IMAP). A protocol is a precise specification of the interactions between communicators. Protocols govern every aspect of communication between computers. The IMAP protocol is used by mail clients to synchronize messages between your local computer and the server. When you delete an email on your email client, IMAP ensures that the email is also deleted from your mailbox on the server, operated by your Internet service provider or mail service. If you have multiple computers connected to the same email account on the server (for example, on your phone and on your desktop), IMAP ensures that an email deleted on one device is also deleted from all other devices. Similarly, an email read on one device is also marked as read on all devices connected to the same email account because IMAP helps the server inform all connected devices about the state of every message on the server.

Protocols Create Efficiency and Precision

In TV shows or movies, you may have heard cryptic conversations between police officers over the radio, or between members of a medical team prior to a procedure. These conversations are generally very different from typical social conversations. Most of the time, you don’t understand the conversation. Yet you may also have noticed that these cryptic conversations obey well-defined rules, with well-defined meanings for every word used in the conversations and are relatively quick and error-free. These cryptic conversations are an example of protocols.147

When you compose an email and hit “Send,” your mail client sends the message to your mail server, which then forwards it to the recipient’s mail server. When the recipient logs into their mail client,

---

their mail client requests their mail server for all new messages and their mail server delivers your message along with all other new emails to the recipient’s mail client for display (Figure 169).

![Image of email system architecture]

**Desktop Mail Clients**

Some of the most popular desktop mail clients are:

1. **Microsoft Outlook**—A widely used email client part of the Microsoft Office suite;
2. **Mozilla Thunderbird**—This open-source email client is from the Mozilla Foundation;
3. **Apple Mail**—The default email client for Apple’s macOS operating system;
4. **Gmail**—Google’s web-based email service can be used as a desktop client through the use of a web browser.

These desktop mail clients work by connecting to the mail server using the appropriate protocol and downloading the email messages to the desktop. The client provides a user-friendly interface for managing email accounts and messages, as well as tools for composing and sending new messages.

**Mobile Mail Clients**

As smartphones are handy and easy to use, some people end up using mobile mail clients as frequently, if not more frequently, than desktop mail clients.

1. **Gmail**—Google’s email service allows users to access Gmail accounts and manage emails directly from mobile devices;
2. **Apple Mail**—The default email client for Apple’s iOS devices, it allows users to manage email accounts from iPhones and iPads;
3. Outlook—Microsoft’s email client is available on both iOS and Android devices. It allows users to manage multiple email accounts, including Microsoft Exchange, Gmail, and others;

4. Yahoo Mail—Yahoo’s email service is available as a mobile app for iOS and Android devices. It allows you to access and manage your Yahoo email account directly from mobile devices.

Receiving, Creating, and Forwarding Mails

Most popular email services—Gmail, Office 365, Yahoo Mail, Apple Mail—are all free and easy to use. If a recruiter you met a few days ago told you to check your email for their response, you may be inclined to check your email every few minutes, whether you are at the mall or a park and have no access to computers. Isn’t it great that you can check your email using your smartphone? With all these services, there are multiple ways to check and receive messages. Some email clients, like Outlook, have both desktop and web versions. Once your desktop Outlook is set up, you just need to open Outlook to receive all the latest messages. However, if the desktop Outlook application is giving you trouble for some reason or you do not have your own machine with you, you could go to outlook.com using any computer and login with your user-id and password to receive and send messages.

If you use Gmail, you probably already know that you can access it from anywhere if you have a phone or a computer with an Internet connection. To access your Gmail using a computer, just type Gmail.com in the location bar of your browser and enter your user-id and password as directed.

Once you log in to Gmail, all your received emails will be visible in the Inbox. The other important folders you may need to access frequently are Sent, Drafts, Trash, and Spam. All email clients have some version of these folders with the same or similar names (Figure 170). As the names suggest, the Sent folder will have all your sent messages; Drafts will have the messages you composed but did not send; Trash will have all the messages you deleted; and Spam will have all the emails that the system has determined to be unwanted or unsolicited. Whenever you want, you can go back to a draft message, reword it, and send it out. Emails in the Trash folder will remain there for a period of time that depends on your email provider. If an email was mistakenly moved to the Trash folder, you can easily restore the message to your Inbox.

It’s useful to regularly check your Spam folder, particularly if you’re expecting an important email, to make sure that your legitimate emails have not ended up there by mistake. Email providers use machine learning algorithms to determine which emails are unwanted and unsolicited—phishing scams, messages from unknown senders, or messages containing malicious content. These algorithms can mistakenly label useful emails as spam.

---

148 To hear about Gmail’s origin story, particularly how Gmail was released by its creator Paul Buchheit in one day, visit Aarthi and Sriram’s podcast episode page, https://www.aarthiandsriram.com/p/the-man-who-created-gmail (accessed June 2023).
To send an email to friends or colleagues, you only need their email addresses. In Gmail, clicking on the large “Compose” button in the top-left corner will open a new email window where you can enter the email addresses of your friends/colleagues in the list of recipients, write a subject, which is a summary of your email, and type your message in the body of the email. If you want to send a copy of your email to others, enter their addresses in Cc (carbon copy) field. The Bcc (blind carbon copy) field lets you send a copy of your email to people without other recipients being able to see the Bcc recipients’ email addresses. This is a very useful feature if you want to send an email to a group of people without revealing their email addresses to each other.
You can also attach files and photos to your email by clicking on the “Attach File” icon (a paperclip at the bottom) and then selecting files and photos (Figure 171). Finally, you just need to click the “Send” button to send the email to your recipients. Outlook and other email clients work similarly, clicking on the “New Email” button (Figure 172) opens a window where you can enter the email addresses of recipients, add attachments (Figure 173), type your message and subject, and send the email by clicking on the “Send” button.

Reading an email is as easy as clicking on the email in your Inbox (Figure 174). If you have any attachments in the email you have received, you can click on the attached file to view the attachment. Keep in mind, clicking on attachments from unknown senders can be dangerous, as it may have malicious content. Though modern mail clients perform various checks to identify malicious attachments, ultimately you are the victim if your computer gets damaged or your information gets stolen. We will discuss this further later in this chapter. Once you have an attachment open, you can download and save it or print it (Figure 175).
FIGURE 174 — Attachments sent or received via email in Outlook are highlighted.

FIGURE 175 — Once attachments are downloaded printing and editing can take place.

To make sure you don’t miss attachments sent with an email, both Outlook and Gmail prominently highlight the name and the document type of the attachments (Figure 176).

FIGURE 176 — Attachments sent or received via email in Gmail are highlighted.

After you finish reading the email, you can reply to the sender of the email by clicking on the “Reply” button. When you open any email, you have received in Gmail, you will see the option to “Reply,” “Reply all,” and “Forward” at the bottom of your message (Figure 177). You can also click on the dots in the top-right corner to open a context-sensitive window that will let you “Reply,” “Reply to all,” and “Forward.” As the names suggest, clicking on “Reply” (this is also represented with an arrow pointing to the left) will open a new email that has the email address of the sender in the “To” field and the original message from the sender quoted in the body of the message. You can also add additional recipients. Then type your reply and click the “Send” button. Clicking on “Reply” to all opens a new email with the sender’s email address and the emails addresses of all other recipients of the original email in the “To” field. You must use “Reply” to all only when your reply is relevant for everybody on the email to avoid bombarding and annoying people with unnecessary emails.
Sometimes you may need to print an email. Thankfully, printing any message in your Inbox is easily achieved by clicking on the printer icon or using the print option in the context-sensitive window. In Outlook, right-clicking on your mouse will open a context-sensitive window that has the print option (Figure 178). You can also use the “File” tab at the top to print email messages.

The option to “Forward” message lets you send an email message you have received in your Inbox to others. Clicking on the “Forward” button (sometimes it is an arrow pointing to the right), will open a new email with the original message quoted in the body of the mail. You just need to add the list of recipients, type your message, and click the “Send” button to forward the email.
Organizing Email into Folders

We saw in the “File Management” chapter on operating systems that folders are the essential mechanism to organize information on computers. Email also supports folders to organize email. By default, most mail services include an Inbox folder for all received mail; a Sent folder for all emails you send; and a Deleted or Trash folder for emails we delete. In addition to these folders provided by the email system, you can create folders to meet your needs. To create a new folder, use the standard procedure of right-clicking a folder to bring up the context menu to create a new subfolder within it (see Figure 179).

To move email between folders, click the email in the inbox and drag and drop it into the folder of your choice. With a judicious choice of email folders, messages can be easily located within the appropriate folders.

Mail Labels

Motivated by its search heritage and leveraging its superior search abilities, Google adopted the principle of “search over structure” to organize email. Google adopted the concept of using labels to organize email. Labels are tags that can be added to any email message. In Gmail’s approach, all messages remain in their default folders—inbox for incoming email, sent for outgoing messages, spam for undesired mail, etc. Users can search messages by text, date, attachments, etc. To organize email, users can attach labels to a message by right clicking the email and selecting one or more labels to attach to the message.

Though folders probably feel intuitive, arguments in favor of labels include the ability to attach more than one label to a message, and ease of locating messages using search compared to navigating folders to locate a message.

Gmail already gives you a few folders like Spam and labels such as Promotions and Social where emails are directed automatically. You can also easily create new labels depending upon your needs, such as Sales, Utilities, or Action Required. These can be added using the “create new label” menu item (Figure 180). The new

labels will appear in the menu on the left. Once you create the label, you can right-click on any email to bring up the context-sensitive menu and attach the label to the message. The message can now be found in the inbox as well as by selecting the label in the menu on the left.

As always, creating too many labels can also make it difficult for you to remember and categorize emails. A small set of well-selected labels is more than sufficient in most cases.

**Mailing Lists**

A mailing list is a feature used in email systems that allows messages sent to one email address to be delivered to another email address or a group of addresses. For example, you can create a list called “students@example.edu” that forwards emails to all students in the school, without having to include individual email addresses in the message. Your teacher may use a mailing list to inform all students and parents in the class about an upcoming activity. Your school principal may use a mailing list to inform all students in the entire school about an issue. Universities routinely use mailing lists for announcements to students, faculty, and staff. Mailing lists make email an extremely powerful service.

However, the convenience of mailing lists also results in everyone receiving tens of emails—personal, official, advertisements, and others—every day. This can make your inbox unmanageable and important emails difficult to find amidst the clutter.

**Mail Filters and Rules**

Fortunately, email clients help you deal with email clutter by allowing you to create email filters to automatically move emails matching specific criteria to a folder (e.g., Outlook) or apply a label (e.g., Gmail). This way, those emails don’t clutter your Inbox.

To create a filter in Gmail, go to “Settings” (the gear icon in the top-right corner) and select the “Filters and Blocked Addresses” tab (Figure 181). Clicking on “Create a new filter” brings up a window where you can enter the filtering criteria. Once you select your criteria, click on Search to see the emails that will get filtered by the criteria. When you are happy with your filtering criteria, you can click “Create Filter” and decide what you want to do with the filtered emails—for example, move them to the “deleted items” or move them to a particular folder automatically.
Outlook and other email providers also offer similar procedures to allow you to filter emails. In Outlook, right click on any email to categorize it into any of the available categories.

Filters are called rules in mail clients such as Outlook. To create a rule in Outlook, just go to the “File” tab and click on “Manage Rules and Alerts.” A popup window opens allowing you to create new rules and modify existing ones (Figure 182).
For example, you could automatically divert emails from mailing lists to a folder called “Lists” that you open once a week to get updated on the information in the lists. This way, emails from your teachers that require your immediate attention will not get buried under promotional or other emails.

**Managing Signatures**

An email signature is information that is automatically added at the end of an email. Signatures typically include contact information or personal touches such as a favorite quote. Creating signatures for your emails saves you the effort of typing basic details every time you send an email. This is particularly useful if you send emails to customers and would like to have your name, address, phone number, email, and company logo in the emails you send.

To create signatures in Outlook, go to the “File” menu and select options. In the Outlook “Options” window, select “Mail” from the left-hand menu and scroll down to the “Signatures” section. In the “Signatures” dialogue box, you can click on “New” to create a new signature (Figure 183).
FIGURE 183 — The Outlook Signature and Stationary menu window allows the user to create and edit signatures.

You can have a different signature for new messages compared to replies and forwards. To add a signature or change the signature of an email, go to the “Insert” tab at the top and click on “Signature.” Choose the signature you want to insert it in your email (Figure 184).

To create signatures in Gmail, go to your account and click on the gear icon in the top-right corner of the page. Select “See all settings.” This brings up the familiar settings menu which we saw in Figure 181 on creating email filters. In the “General” tab, go down to “Signature” and create a signature by giving a name to your signature and adding the signature text (Figure 185). As in Outlook, Gmail also allows you to create different signatures for new emails compared to reply/forwards. You must save the signatures by clicking on “Save Changes” in the bottom of the page to activate the signatures.

FIGURE 184 — To insert a created signature in Outlook, go to the signature function under the Insert tab.
Email Sensitivity, Security, and Delivery Options

At times, you may want to send an email that is personal or confidential. Email clients can help maintain some level of privacy by disabling the common methods used to distribute messages, such as forwarding and printing. Users can still take screenshots of your messages and send those out if they choose, but only with additional effort.\footnote{For more information about Gmail’s confidential mode, see “Protect Gmail Messages With Confidential Mode,” https://support.google.com/a/answer/7684332?hl=en (accessed June 2023).}

In Gmail, you can use the confidential mode to protect sensitive information, so the recipients cannot forward, copy, print, or download messages. You can also require your recipients to receive a passcode from Google to see the message and set an expiration date for the message. To invoke these options, in the “Compose” email window, click on the “lock” icon in the bottom (Figure 186) to open the “Confidential mode” window (Figure 187).
Similar options exist in Outlook. You can change the importance and sensitivity of an email—mark it “Personal,” “Private,” or “Confidential.” To access these options, when you open a new email window, go to the “Options” tab. Clicking on “More Options” will open the “Properties” window that has a range of security settings and delivery options (Figure 188). You can also make sure the email is not delivered before a certain date and set an expiration date for the message.

FIGURE 187 — In Gmail users can send confidential emails to protect information.

FIGURE 188 — Under the Options tab in Outlook, users can change the importance, sensitivity, and delivery options of an email.
Email Contacts

Contacts are people you communicate with. They are usually family, friends, and business associates. Contact management features of productivity applications allow you to save phone numbers, email addresses, mailing addresses, and other relevant information about your contacts for ready access. Most email services and clients let you save contacts and create groups of contacts to make it easy to send emails to your colleagues or friends. In Gmail, you can access contacts by clicking on the “Google Apps” icon in the top-right corner of the screen (it looks like a square made of nine smaller squares) see Figure 189). Click on “Contacts” to open the contacts manager. You can add and delete contacts. You can also group contacts by labeling them. You can create a label called Friends and add all your friends to it (Figure 190). When you want to send an email to your friends, just type “Friends” in the To or Cc field to send an email to all your friends. This feature is tremendously useful when you send emails to contact groups frequently.

Automated Messages

A frequent need in work environments is to know when a recipient is busy or out of the office and unable to respond promptly to emails. This allows email senders to take alternate measures to complete their tasks. Email services allow you to send automated replies in these situations. Automated messages are preconfigured responses to all incoming messages. Automated messages tell folks emailing you that you are unable to reply—for example when you are on vacation or outside of the reach of the Internet. A best practice for automated messages is to share the contact information of your colleagues who cover for you while you are unable to respond to messages. This allows senders to reach out to your colleagues for any assistance to complete their tasks.

Since automated messages are commonly used when users are on vacation, they have come to be

152 This is called a waffle. For some context on the use of food icons on websites, see “How Did Food Get In My Website and Digital App?” https://bluezoocreative.com/2013/10/navigation-trends-hamburgers-waffles-and-breadcrumbs/ (accessed June 2023).
known as vacation responders, vacation messages, or simply, out of office messages. To turn your vacation responder on in Gmail, click on the “gear” icon in the top-right corner and access settings. Under the “General” tab, scroll down to the “vacation responder” and turn it on. You can set the start and the end dates of the vacation response and type your Subject and Message (Figure 191).

Outlook and other email clients also have similar capabilities. To set your vacation response in Outlook, go to the “Files” tab and then click on the “Automatic Replies” tile to access the window that allows you set automatic replies (Figure 192).

This completes our discussion of email. Email is one of the core technologies enabling our digital world, particularly at work. Email’s convenience and efficiency helps professionals to exchange information and speed up decision making. Email’s archiving capabilities make it a valuable record-keeping tool in organizations. Effective email use can greatly improve your own productivity.
Using Calendars to Schedule Meetings and Tasks

We now introduce calendars. Calendars are productivity applications that help individuals and teams manage their schedules, appointments, and tasks. Calendars allow users to create and manage events; view schedules in various formats such as daily, weekly, or monthly; schedule meetings; and share their calendars with colleagues or clients. Calendars are typically integrated with email, so we will discuss calendars alongside email.

To access Gmail’s calendar, open your Gmail and click on the “calendar” icon on the right pane (Figure 193). If the calendar opens as a pane to the right of the Gmail Inbox, you should click on the “Open in new” tab icon to make it easier to see your entire weekly calendar.

If you want to schedule a meeting with others, click on the “Create” button and select “Event” (Figure 194). Since the Covid pandemic, videoconferencing capabilities have become tightly integrated with calendars. Goggle calendar allows you to add Google Meet video conferencing to any meeting with up to a hundred attendees. You can click on “More options” to open a detailed window where you can enter the message you want to send to your attendees, specify meeting and notification time, and add location. When you click on “Save,” the meeting is added to your calendar and an email with the event information is sent to all invitees. This email is called a meeting invite. The email has options for the receiver to add the event to their own calendar. This is the basic operation of calendars.
FIGURE 194 — Creating an event in Google Calendar. Step 1 (top)—create the event. Step 2 (bottom)—add details about the event.
As you see in Figure 194, you can make the meeting recurring (shown as repeat in the figure) if needed. Setting up a recurring meeting is useful if you plan to meet the same group of people on a regular basis. For example, if your student club meets at the same time and place each week, setting up the club meetings as a recurring appointment can easily put all the club meetings for the year on every club member’s calendar with just one click.

Microsoft’s Outlook software is also integrated with calendaring software that allows you to schedule audio and video meetings and create appointments to remind yourself of specific tasks. Click on “New Meeting” to open a window where you can specify all the details about the meeting, including the date and time of the meeting, recurrence, required attendees, optional attendees, location, and the message your attendees will receive (Figure 195). In businesses, Outlook is typically integrated with Zoom or Teams to allow you to create video meetings with ease as part of the event creation.

FIGURE 195 — Creating a new meeting in the Outlook calendar. Step 1 (top)—create the New Meeting. Step 2 (bottom)—add details about the meeting.
Clicking on the “Required” or “Optional” button of the meeting window opens another window—the address book—where you can pick email addresses of your attendees and even book a location for your meeting (Figure 196).

![FIGURE 196 — Outlook users can utilize the address book to filter attendees.](image)

If you are scheduling a meeting with your colleagues, you may have partial access to their calendars to be able to see when they are free. This allows you to schedule a meeting at a time that works for everyone. Click on the “Scheduling Assistant” tab to see when your attendees are free or busy in a grid format (Figure 197). Bold colors indicate times when a person is busy and gridlines indicate times when they may be free. You can change the time of your meeting or the day of your meeting to make it easy for others to attend. In this example, both the required and optional attendees are free at 2:30 P.M. on Monday (January 30th). Once you pick a time that works for everyone, you can go to the “Meeting” tab and send the invitation.
Before we close the chapter, it is useful to draw your attention to a few security concerns related to email. Most cybersecurity issues arise from individuals trying to reach your computer to steal information. Since email is a mechanism for users (including malicious users) to reach you, email has emerged as an important cybersecurity vulnerability. According to the data breach investigations report published by Verizon, over 80% of all computer breaches involve the human element.  

We highlight a few important cybersecurity considerations below.

Phishing Attacks

Since we keep a lot of valuable personal information and company secrets digitally, cybercriminals have much to gain by tricking you into allowing them to use your credentials to steal information that you have access to. Perhaps the most common method to do so is phishing. Phishing is the use of emails that appear to be from reputable companies, but are really designed to get users to reveal personal information, such as passwords and credit card numbers. A common method is to send emails that appear to be from a bank or ecommerce site asking you to refresh your credentials. When you click on the link and log into the site, the operators get your credentials, which they can use to make purchases using your account.

Phishing attacks come in the form of deceptive emails or text messages that may ask you to install a software or divulge personal information. The attacks are increasing in frequency and getting more sophisticated and dangerous, so it is important to be watchful when you receive a suspicious email or text from an unknown person. Don't be fooled by shopping and tax deals or shipments you are about to receive unless you are sure about the senders. Sometimes, you may also receive a phone message that lends credibility to the email or text message, adding to the urgency of the request. To get your personal information, criminals also create fake websites that look exactly like well-known and reputable government or business websites. The result of a successful attack can be disastrous.

In a notable case, Facebook and Google lost over $100 million in a phishing scam where a person in Lithuania tricked employees into wiring money to his bank account. This just goes to show that nobody is above these scams, not even people working in tech companies themselves.

Spear Phishing

A spear phishing attack is more sinister and malicious because it is targeted at a particular individual. The cybercriminals often do their homework on social media; they know who you are—may know the names of your family members, managers, and friends. They may use your manager's social media posts to make the attack even more directed. Let's say you work in the purchasing department of a company and receive an email from your boss directing you to buy supplies in a hurry—to create a temporary invoice, approve it, and send $1000 to an account. The attacker may even customize the message and say, "I talked to our director, Jane, who is at her daughter's wedding. She's good with it and will sign off when she comes back to work next week." In this example, the hacker knows that your manager is traveling, and his boss is at her daughter's wedding and won't be back at work for some time. The criminals might even have hacked your boss's email account and were just waiting for the perfect moment (when he is traveling, and his boss is at an important event) to send the email from his address.

Targeted attacks can be particularly difficult to detect, so it is important to spend some time and pay attention to small details, like the tone of the request. Have you ever received a request like that?

---

154 This is the case of Evaldas Rimasauskas, who was prosecuted in 2019. You can read about it at https://www.reuters.com/article/us-cyber-fraud-tech/lithuanian-pleads-guilty-in-u-s-to-massive-fraud-against-google-facebook-idUSKCN1R12FB (accessed June 2023).
from your manager/friend in the past? Run the request by your manager or someone similar. Just like banks and other institutions that use multiple ways to authenticate users, even you should employ relevant means to validate unusual requests by talking to others or running the request by specialists who deal with cybercriminals regularly.155

Emails Don’t Go Away

Your email communication serves as a system of record from a legal perspective. When you send a mail, a copy of it is retained on your provider’s email servers as well as at the receiving end. Even if you delete sent emails, they remain on the servers and in the inboxes of your recipients. As only you are expected to be able to send emails from your address, any message you send is a written record of your intent and is admissible as digital evidence in most courts. Therefore, before you send out an email, always remember the permanence and system of record aspect of emails. Also, it is important to re-read important emails a few times for tone, intent, and accuracy. The written word generally appears less polite than the spoken word. When in doubt, be extra-polite when writing emails.

Because of the ease with which we can send emails we sometimes end up writing things we may regret later. Emails do not communicate your facial expressions. You may call your boss “a tough boss” jokingly in his presence. However, writing the same thing in an email may take on a serious note and may be construed as rude or even threatening. Many people make a rule of never sending an email in anger. If you do type an angry email, let it sit there for a day or two before you hit the “Send” button.

---

155 A colleague of one of the authors of this book, a professor at a university, became a victim of a phishing attack and lost $500. He was asked to buy iTunes in a hurry as a birthday gift. These attacks are all around us.
**Attach File:** A feature in the email client that allows users to share files through email messages

**Desktop Mail Client:** Desktop mail clients connect to mail servers, downloads email messages, and displays them to the user on desktop computers

**Draft (Email Folder):** A folder within the email client where messages that are created but not sent are stored

**Email Address:** Email addresses are uniquely assigned or created by users, and are used to send emails to specific users or parties

**Email Contact:** Within the email client a list of colleagues, friends, or other users that have previously interacted with your email address are saved as email contacts

**Forward:** To send an email to someone else or to a different address after you have received it; forward allows you to type in a whole new set of recipients

**Internet Message Access Protocol (IMAP):** Provides an ease of access to emails from any location or device without the need of downloading it to your hard drive

**Inbox:** A repository for all received emails within the email client

**Mail Client:** A software program that allows you to manage and send electronic messages (emails)

**Mail Server:** Servers tasked with handling the data and traffic of email client users; these servers handle the backend operation of email clients

**Messages (Emails):** Electronic forms of correspondence that allows users to communicate and share files through the Internet

**Mobile Mail Client:** Mobile mail clients offer portable connection to mail servers and the ability to download and display email messages by utilizing mobile computing devices

**Phishing Attack:** An attempt to steal information from victims through the use of social engineering techniques and various communication channels

**Reply:** To answer; reply only sends the new message to the original sender

**Reply All:** To answer; reply all sends the new message to the original sender and all other recipients on the To and Cc lines

**Scheduling Assistant:** Email scheduling assistants help users identify availability for meetings, this allows users to schedule in advance while increasing attendance

**Send:** The action of an email client sending a message to the mail server, which then forwards it to the recipient’s server

**Sent (Email Folder):** After you send an email message, you might want to find that email; your email service stores those messages in the Sent Items folder

**Signature:** Email signatures allow users to customize personalized messages that are appended to the end of emails, and typically contain the users name and contact information
**Spam (Email Folder):** A folder within the email client where messages that are deemed unwanted or unsolicited are sent.

**Spear Phishing:** An attack used to steal the personal information of a specific target or person; the defining characteristic of spear phishing is that the attack is targeted for a specific purpose; named after a phishing method.

**Trash (Email Folder):** Items that you delete are moved to the Trash folders, but aren't permanently deleted until those folders are emptied.
I’m Admitted to USF!

Carl is ready to graduate high school and has applied for admission to the University of South Florida. He has waited weeks to hear from the admissions office and today he finally received an email in the inbox of his high school account. Take a close look at the following email:

From: Clinton Daniel <clinton.daniel_usf_admissions@gmail.com>
Date: Monday, April 10, 2023 at 8:59 AM
To: Carl Student <carl_student@hcps.net>
Subject: Congratulations! - You’ve Been Admitted to USF for Fall 2023

Welcome to the Herd

Hi Carl,

On behalf of the USF President, we welcome you to the University of South Florida!

Congratulations!

As part of our admissions process, you must fill out a Federal Student Aid packet.

Go here to apply for Federal Student Aid: [Click here](https://www.usf.edu/business/about/bios/daniel-clinton.aspx)

Dr. Clinton Daniel
Associate Professor of Instruction, School of Information Systems and Management
Academic Director, BS in Business Analytics & Information Systems
University of South Florida, Muma College of Business
Office: (813) 974-6765

Question 1: What information in this email is unusual and what kind of attack is this? Why is the information unusual?

Question 2: Why do you think there is a link in the email asking Carl to fill out a Federal Student Aid application?